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MAHESHWARI PUBLIC SCHOOL, AJMER 
Class Test I; Session: 2023-2024 

Class: IX; Subject: English 
Time allowed: 45 minutes     Maximum Marks: 20  
General Instructions: 

i. This question paper contains four sections READING, WRITING, GRAMMAR                  
and LITERATURE. 

ii. Attempt questions based on specific instructions for each Part/ Section. 
 

Section A- Reading (5 Marks) 
Q1. Read the following passage carefully.                        (1x5=5) 
1. When Rajat, a student studying for the Class X Board examination approached Dr. 
Anoop Mishra of the Fortis Hospital, who had put on six kilograms, during preparation 
leave, for advice, he was told that the lack of physical activity was the primary cause of 
weight gain.  

2. He further advised him to follow a few significant tips. As Rajat's appetite had gone up 
and he had begun to snack frequently, Dr. Mishra asked him to give up the habit and 
have small meals at frequent intervals. He was also told not to skip a meal. In case, he 
still felt the urge to snack, he was advised to have sprouts and salads in lieu of snacks 
loaded with fat and eat fruit in place of snack with refined sugars.  

3. To avoid the temptation of munching on biscuits, chips and namkeens, he was advised 
to munch carrots, cucumber and fruits. To keep up his metabolism, and be able to 
concentrate for longer hours on his books, he was advised to avoid heavy meals, 
especially late at night. He needs to expose his body to sunlight for at least fifteen minutes 
a day to imbibe Vitamin D, a good vitamin for regulation of weight and also for the brain. 

4. When it came to cold drinks, Rajat was advised to drink toned milk and nimbu pani to 
help him get rid of untimely hunger pangs. Also green teas he was told was a metabolic 
booster and could be tried out. 

Answer the following questions briefly.       
(a) State the reason why Rajat approached Dr Mishra. 
(b) What was he advised to overcome the temptation of eating biscuits and namkeens? 
(c) Mention the substitute that was advised to Rajat in place of snacks. 
(d) Rajat was advised to avoid heavy meals to__________ 
(e) (i) Find the word from the above passage that is same as ‘to meet or communicate 
directly with a person’ in paragraph 1. 

OR 
(ii) Find the word from the above passage that is antonym of ‘rarely or not much’ in 
paragraph 2. 
 

Section B- Writing (3 Marks) 
Q2. You are the Cultural Secretary of Delhi Public School, Roorkee. You have been asked 
to inform students of Class VI to XII about an Inter-House Dramatics Competition. Draft 
a notice in not more than 50 words with necessary details. 
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Section C- Grammar (2 Marks) 
Q3. Answer the questions by selecting the most appropriate option for each.      (1x2=2) 
(a) It is a rule and you ________ obey it strictly. 
(i) should         (ii) could            (iii) must             (iv) need to 
(b) ________ you play with us? 
(i) May             (ii) Will               (iii) Shall             (iv) Should 

OR 
(c) I ________ swim across the river when I was young. 
(i) could           (ii) can               (iii) should           (iv) must 
 

Section D- Literature (10 Marks) 
Q4. Read the extract and answer ANY THREE questions that follow.                   (1x3=3) 
 
“Many times, I rubbed my hands to understand what was written.”  

(a) The ‘I’ in the above lines refers to : 
(i) Sudha Murthy           (ii) Triveni             (iii) Krishtakka               (iv) Saraswati 
 
(b) The ‘pages’ were of a : 
(i) kannada newspaper                              (ii) magazine 
(iii) novel ‘Kashi Yatre’                               (iv) weekly magazine ‘Karmveera’ 
 
(c) “Rubbing my hands over the pages” suggests the speakers: 
(i) disappointment         (ii) desperation     (iii) deep yearning         (iv) regret 
 
(d) Why was the speaker rubbing her hand on the text? 
(e) Why was the above line spoken? 
 
Q5. Attempt ANY TWO of the following questions in 30-40 words.                        (2x2=4) 
(a) Write any two character traits of Sudha Murthy . 
(b) The poem 'The Brook' draws a parallel with human life. Explain the parallelism 
between the two. 
(c) Quote the refrain of the poem, 'The Brook'. Explain it briefly. 
 
Q6. Attempt ANY ONE of the following questions in 60-80 words.                        (1x3=3) 
(a) Describe the character of the grandmother in the lesson ‘How I Taught My  
 Grandmother to Read’. 
(b) What kind of an attitude does the brook reflect in general towards the various situations 
that it comes across on its journey towards the river? What message do we get from 
it?          
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fuEufyf[kr x|ka'k dks i<+dj iwNs x, ç'uksa ds fy, mfpr fodYi dk p;u dhft, & 

iM+ksl dh nqdkuksa ds r[rksa ij cSBs ;k cktkj esa [kM+s yksx ?k`.kk ls mlh L=h ds laca/k esa ckr dj 

jgs FksA ml L=h dk jksuk ns[k dj eu esa ,d O;Fkk&lh mBh] ij mlds jksus dk dkj.k tkuus dk 

mik; D;k Fkk\ QqVikFk ij mlds lehi cSB ldus esa esjh iks'kkd gh O;o/kku cu [kM+h gks xbZA 

,d vkneh us ?k`.kk ls ,d rjQ Fkwdrs gq, dgk] “D;k tekuk gS! toku yM+ds dks ejs iwjk fnu 

ugha chrk vkSj ;g csg;k nqdku yxkdj cSBh gSA”  

cqf<+;k ds fy, yksxksa }kjk çdV fd;k x;k ?k`.kk dk Hkko D;k n'kkZrk gS & 

¼v½ laosnughurk     ¼c½ cqf)ghurk     ¼l½ lkeF;Zghurk      ¼n½ buesa ls dksbZ ugha  

ys[kd us L=h dh O;Fkk tkuus ds fy, D;k mik; fd;k\ 

¼v½ mlus Lo;a nq[k dk vuqeku yxk;k                   ¼c½ yksxksa dh ckrksa dks lquk  

¼l½ yksxksa ls utj cpkdj cqf<+;k ls ckr dh              ¼n½ lHkh fodYi lgh gS  

“D;k tekuk gS! toku yM+ds dks ejs iwjk fnu ugha chrk vkSj ;g csg;k nqdku yxkdj cSBh gSA” 

bl vkykspuk ds LFkku ij yksxksa dks D;k djuk pkfg, Fkk\  

¼v½ cqf<+;k dks [kjcwts cspus ls jksduk ugha pkfg, Fkk  

¼c½ [kjcwts cspus esa cqf<+;k dh enn djuh pkfg, Fkh  

¼l½ /ku dk çca/k dj cqf<+;k dh lgk;rk djuh pkfg, Fkh  

¼n½ cqf<+;k dks lwrd ds fo"k; esa le>kuk pkfg, Fkk  

 

fuEufyf[kr i|ka'k dks i<+dj iwNs x, ç'uksa ds fy, mfpr fodYi dk p;u dhft, &  

vc dSls NwVS jke uke jV ykxhA  

çHkq th] rqe panu ge ikuh] tkdh v¡x&v¡x ckl lekuhA 

çHkq th] rqe ?ku cu ge eksjk] tSls fprou pan pdksjkA 

mijksä iafä;ksa esa jSnkl us fdl lqxaf/kr inkFkZ dk mYys[k fd;k gS\  

¼v½ ckl                 ¼c½ v¡x            ¼l½ panu          ¼n½ fprou  

vuqi;qä tksM+s okyk fodYi gS & 

¼v½ panu & ikuh         ¼c½ ?ku & eksjk     ¼l½ cu & ckl     ¼n½ pan & pdksjk  

(3x1=3) 
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iz”u 7 
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fuEufyf[kr ç'uksa ds funsZ'kkuqlkj mÙkj nhft, & 

okD; esa ç;qä gksus ds ckn in fdlls çHkkfor gksrs gSa\ 

¼v½ fyax] opu           ¼c½ dkjd       ¼l½ dky        ¼n½ mijksä lHkh  

'kCn in dc cu tkrk gS\ 

¼v½ O;kdj.k ds fu;eksa esa c¡/kdj     ¼c½ fu;eksa ls Lora= gksdj 

¼l½ o.kksZa dh lkFkZd /ofu cudj     ¼n½ fn, x, fodYiksa esa ls dksbZ ugha 

„eksgu us [kkuk [kk;kA‟  bl okD; esa js[kkafdr dh igpku dhft, & 

¼v½ laKk in                      ¼c½ loZuke in      

¼l½ fo”ks’k.k in                    ¼n½ dksbZ Hkh fodYi lgh ugha 

  

funsZ'kkuqlkj mÙkj nhft, & 

fuEufyf[kr esa ls fdl 'kCn esa milxZ ugha gS\ 

¼v½ viokn            ¼c½ ijkt;            ¼l½ çHkko            ¼n½ vkstLoh  

„vf/kdkjh‟ 'kCn esa milxZ tqM+k gS & 

¼v½ v                ¼c½ vf/k              ¼l½ vf/kd           ¼n½ v/k~ 

„vR;qfä‟ 'kCn ls milxZ ,oa ewy 'kCn vyx dhft,A 

¼v½ vr~ $ ;qfDr       ¼c½ vf/k $ ;qfDr      ¼l½ vR; $ mfDr     ¼n½ vfr $ ;qfDr 

 

fuEufyf[kr ç'uksa dks /;kuiwoZd i<+dj mi;qä fodYi pqfu,A 

lksus ds lkFk lqgkxk fey tk, rks D;k gksrk gS\ 

¼v½ vkHkw"k.k curs gSa                     ¼c½ dgkor curh gS  

¼l½ lksus dh v'kqf);k¡ nwj gksrh gS         ¼n½ lksuk [kjkc ugha gksrk  

„tkdh Nksfr txr dm ykxS rk ij rqgha <jSA‟ bl iafä esa dfo us fdl lkekftd folaxfr dk 

mYys[k fd;k gS\ 

¼v½ cky&fookg        ¼c½ vehj&xjhc      ¼l½ fo/kok fookg       ¼n½ Nwr&vNwr  

 

fuEufyf[kr ç'uksa ds rdZiw.kZ mÙkj ,d iafä esa fyf[k,A 

lk¡i ds dkVus ij Hkxokuk dh ek¡ mls M‚DVj ds ikl u ys tk dj vks>k ds ikl bykt ds fy, 

D;ksa ys xbZ\ vkt Hkh xzkeh.k ra=&ea= vkSj >kM+&Qwad esa fo'okl djrs gSaA vkids fglkc ls bldk 

çeq[k dkj.k D;k gks ldrk gS\ 

fons'kksa esa fo|kFkhZ jax&fcjaxh iks'kkdksa esa fo|ky; tkrs gSa fdarq gekjs ns'k esa fo|ky; dh iks'kkd 

vfuok;Z gSA fopkj djds fo|ky; iks”kkd dh vfuok;Zrk dk ,d mfpr dkj.k fyf[k,A 

 

fuEufyf[kr ç'uksa esa ls fdUgh nks ç'uksa ds mÙkj 40&50 'kCnksa esa fyf[k,A 

lw> dk jkLrk uk ikdj cspSuh esa rst dneksa ls pyrs gq, ys[kd D;k&D;k lksprk tk jgk Fkk\ 

ftank vkneh uaxk Hkh jg ldrk gS] ijarq eqnsZ dks uaxk dSls fonk fd;k tk,\ iafDr ds ek/;e ls 

ys[kd D;k dguk pkgrk gS\ Li"V dhft,A 

vc dSls NwVS jke jV ykxhA in esa Hkxoku vkSj Hkä ds chp dfo us laca/k crkrs gq, fdl&fdl 

ls rqyuk dh gS\ 

(3x1=3) 
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Maheshwari Public School, Ajmer 
Class: IX; Subject: Information Technology(402) 

Class Test – 1; Session: 2023-24 
 

 
Time Allowed: 45Mins.                     Maximum Marks: 20 

General Instructions: 

1. All questions are compulsory to attempt however, internal choice is provided. 

2. This paper consists of total 21 questions. 

Section-A Objective Type Questions 
 

A. Answer any eight questions out of given nine questions.             (1x8=8) 
 

1. The Libre office Writer Application opens a new document with the temporary name. 

a) Document   b) Book     c) Untitled 1           d)Book 1 

2. Where do you type the text in LibreOffice Writer? 

a) Text Box                 b) Document window       c)Application Window    d)None of these 

3. The vertical Ruler formats the ______ alignment of text. 

a) Top    b) Right     c)Vertical      d)Horizontal 

4. Which Menu contains the New Option? 

a) Edit   b) File      c) Format     d)Tools 

5. What is the file extension of LibreOffice Writer document? 

a) .odt   b).odp      c).odd      d).odw 

6. The Key is pressed when you select non-consecutive text. 

a) Ctrl   b)Alt      c)Shift      d)Tab 

7. Which of the following is not available on the formatting toolbar ? 

a) Copy button  b)Bold button     c)Underline button         d)Font color button 

8. Which of the following is a correct way to access the Image dialog box ? 

a) Insert>Image>Picture  b)Insert>shape    c)Format>Picture     d)Insert>Image 

9. Which of the following is a keyboard shortcut to open an existing document? 

a) Ctrl + C   b)Ctrl + Y     c)Ctrl + X     d) Ctrl + Z 

B. Fill in the blanks with suitable word for any six of the following:              (1x6=6) 

10. LibreOffice suite which is ___________ and ____________ software. 

11. A ____________ refers to a set of written pages. 

12. The term WYSIWYG stands for ________________. 

13. Writer is a part of _____________ 

14. To maintain the height and width ratio of a shape, hold down the ____________ key. 

15. You press the __________ keys to open the Template dialog box. 

16. The I-beam mouse pointer is referred to as a __________ cursor. 

 
Section-B Subjective Type Questions 

 

C. Answer any three questions out of given five questions.               (2x3=6) 

 

17. Explain the use of Navigator? 

18. What are the options to save a Document? 



19. How is page break useful ? 

20. What are Non-Printing character? 

21. Rajan is confused about the functions of all the shortcut key combination, he has learnt till now. So, help him to 

fill the following table? 

 

Shortcut key Functions 

Ctrl + A  

Ctrl + N  

Ctrl + S  

Ctrl + O  
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Maheshwari Public School, Ajmer 
Class Test I; Session: 2023-2024 

Class: IX; Subject: Science 
 

Time Allowed: 45 minutes.                                                                Maximum Marks: 20 
General Instructions: 

 1. All the questions in this paper are compulsory to attempt. 
 2. Marks are indicated against each question. 

1. Brass is an example of          1 
(a) Suspension    (b) Pure substance (c)  Colloid    (d) Homogeneous mixture. 

2. Amoeba acquires its food through a process termed as:     1                                              
(a) Exocytosis    (b) Endocytosis   (c) Plasmolysis   (d) None of these. 

3. A body, after travelling some distance, returns to its starting point. Which of the 
following is true?          1                                              
(a) average speed is zero  (b) average velocity is zero  
(c) distance travelled is zero  (d) displacement is not zero. 

4. Match the column I with column II and select the correct option:    1          

COLUMN -I COLUMN- II 

1.  Robert  Hooke (i) First living cell 

2.  Robert Brown (ii) Cell theory 

3. Schlieden  (iii) Nucleus 

4. Leeuwenhoek (iv) Cork cell 

(a) (i), (ii), (iii), (iv)        (b) (iii), (iv), (i), (ii) 

(c) (iv), (iii), (ii), (i)        (d) (ii), (i), (iii), (iv) 

5. (a)Your science teacher displayed a bowl of fruit and vegetable salad to the students. 

Your classmate examines the mixture and was able to distinguish fruits from 

vegetables. Identify the type of mixture. 

      (b) Provide a second illustration of this type of mixture.        (1+1) 

6. State any one point of difference between a cell wall and a cell/plasma membrane. 
       Also give the chemical composition of the two.                                               (1+⅟₂+ ⅟₂) 

7. What do you mean by uniform motion. State whether the motion of the hands of a clock 

is uniform or non-uniform.                  (1+1) 

8. On dissolving sugar in water, a true solution is obtained. Give any three reasons to 

support the fact that mixture so obtained is a true solution only.       (1×3) 

9. Two beakers ‘A’ and ‘B’ contain distilled water and concentrated sugar solution 
respectively. Equal number of raisins were kept in them for a few hours and then taken 
out. 
(a) State the physical appearance of the raisins which were taken out of the two 

beakers ‘A’ and ‘B’ respectively after few hours. Explain the reason for the 
difference in their physical appearance. 
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(b) On the basis of above observation, categorise the two solutions as hypotonic and 

hypertonic.                                                                                                       (2+1) 

10. Case study based 

Distance and displacement are two quantities that seem to mean the same but are 
different with different meanings and definitions. Distance is the measure of “how much 
distance an object has covered during its motion” while displacement refers to the 
measure of “how far the abject actually from initial place.”  

Using the data given below answer following questions.     

A car moving along in a straight highway from point P to point Q to point R and to 

point S, then back to point Q and finally to the point R as shown in the figure below. 

 

(a) Find the distance travelled by car. 

(b) Find the displacement of the car. 

(c) If the time duration for this journey is 3 hours, find the average speed and average 

velocity of the car.         (1+1+2) 

 



Maheshwari Public School, Ajmer
Class Test-I; 2023-24

Social Science; Class-IX

Time-45 minutes MM-20
Instructions:
 Altogether there are 10 questions.
 All questions are compulsory.

Q1. In Mexico, elections to elect the President are held after every (1)
(a) Four years (b) Six years
(c) Five years (d) Seven years

Q2. In Fiji, the vote of an indigenous Fiji has ______ value than
that of an Indian Fijian. (1)
(a) one (b) equal
(c) less (d) more

Q3. What is the name of the Chinese parliament? (1)
(a) National People’s Committee
(b) National People’s Conference
(c) New People's Congress
(d) National People's Congress

Q4. In Pakistan, General Parvez Musharraf led a military coup in (1)

(a) January 1990 (b) March 1999
(b) September 1999 (d) October 1999

Q5. Modern democracies are (1)

(a) Direct democracies (b) Partial democracies
(c) Representative democracies (d) Merely democracies

Q6. Assertion: India covers 2.4% of the total geographical areas of the world. (1)

Reason: The land mass of India has an area of 3.28 million square Km.
Read the statements and choose the appropriate option:

(a) Both A and R are true, and R is the correct explanation of A.

(b) Both A and R are true, and R is not the correct explanation of A.

(c) A is true but R is false.

(d) A is false but R is true.

Q7. Uttarakhand, Uttar Pradesh, Bihar, West Bengal and Sikkim have
common frontiers with (1)

(a) China (b) Nepal
(c) Bhutan (d) Myanmar

Q8. Which island group of India lies to its southeast? (1)

(a) Puducherry (b) Andaman and Nicobar
(c) Lakshadweep (d) Daman and Diu



Q9. India is bounded by the young fold mountains in (1)

(a) Northeast (b) Southwest
(c) Northeast and Northwest (d) Southeast and Southwest

Q10.India has a land boundary of about________Kms. (1)

(a) 17200 km (b) 30100 km
(c) 15200 km (d) 16500 km

Q11.Give two arguments in favour of democracy. (2)

Q12.Name any four states of India from where the tropic of Cancer passes. (2)

Q13. Briefly mention any three methods used by the PRI to remain in power. (3)

Q14. India's contacts with the world have continued through the ages but, her

relationships through the land roots are much older than her maritime

contacts. Justify the statement in light of India's contribution to the world. (3)



MAHESHWARI PUBLIC SCHOOL, VAISHALI NAGAR, AJMER 

CLASS TEST: 1; SESSION:2023-24 

CLASS: IX; SUBJECT: MATHS 

TIME: 45 Min                                                                                            M.M.:20 

 

1. Express 0.27 in the form of 
𝑝

𝑞
  1 

2. Find 2 rational numbers between 
1

6
  & 

2

5
.                                                              1                                           

3. Simplify: (3+√23) -2√23     1 

4. Write the perpendicular distance of point (-3,2) from x-axis.                                1        

5. Simplify 
√3−1

√3+1
         2 

                                      OR  

Simplify: [(6251/2)
−1/4

]
2

 

6. Represent √7.3 on the number line.     2 

7. If the coordinates of two points are P (- 6,3) and Q(8,5).    2 

Find (abscissa of P - ordinate of Q) 

8. Find the value of ‘a’ and ‘b’ If   
√3+√2

√3−√2
 =a+b√6    3 

9. What will be the position of point P(3,2) if    3 

i) ordinate is multiplied by (-1) 

ii) abscissa is multiplied by (-2) 

iii) abscissa and ordinate both are added to (-5) 

                                    OR 

Find mirror image of the point (2,-3) with respect to 

a) X- axis          b) Y-axis           c) Origin 

10. Simplify: 
−3

√2+ √3
 + 

3√2

√6+ √3
 - 

4√3

√6+ √2
                                                                            4 

                                     OR 

If x = 3 + 2√2, then find x2 + 1/x2  

 

***** 


